LEIAG-Excel Workshop

Random Sample

Excel has a simple formula we can utilize to obtain a random sample (cases, citations, city,
etc.)

At the Sheriff@ Department, we are able to run a case management report that generates
the following information: case #, report date, Assigned Investigator, Crime Category, City
and Case Status)

If we want to obtain a random sample of cases, we will do the following:

Left click on column A and either select Copy, or press Ctrl + C (shortcut for copy option).
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L‘M Assigned Date - Assigned Investigator - Crime Category - City
| 2 | 18100001 2/2/2018 YOUNG, MICHAEL Aggravated Assault San Mar
| 3 | 18100002 2/2/2018 JONES, JESSICA Burglary/Breaking & Entering Vista
| 4 | 18100003 2/2/2018 HERNANDEZ, REYNALDO Counterfeiting/Forgery Vista
| 5 | 18100004 2/2/2018 SMITH, KIRSTIN Credit Card/Automatic Teller Fraud Imperial B
| 6 | 18100005 2/2/2018 YOUNG, MICHAEL Destruction/Damage/Vandalism of Property Vista
| 7 | 18100006 2/2/2018 JONES, JESSICA Disorderly Conduct San Mar
| 8 | 18100007 2/2/2018 HERNANDEZ, REYNALDO Drug/narcotic Violations Imperial B
| 9 | 18100008 2/3/2018 SMITH, KIRSTIN False Pretenses/Swindle/Confidence Game San Mar
| 10| 18100009 2/3/2018 YOUNG, MICHAEL Forcible Rape Vista
| 11| 18100010 2/3/2018 JONES, JESSICA Motor Vehicle Theft San Mar
| 12| 18100011 2/3/2018 HERNANDEZ, REYNALDO Robbery Vista
| 13| 18100012 2/3/2018 SMITH, KIRSTIN Shoplifting Imperial B
| 14| 18100013 2/3/2018 YOUNG, MICHAEL Simple Assault San Mar

15 12100014 2/2/2018 IONFES _IFSSICA Tresnassaf Real Pronarty San Mar

Left Click on Random Sample Tab (located on the bottom of the screen) and paste the data
by Clicking on the paste option or by pressing Ctrl+V (shortcut to paste data).

Type the word Random (or any title you like) on column B1.

If you want the same cell color and type of text, you can click on cell Al and select Format
Painter. Then Left Click on cell B1. (this action copies the format from cell A1 to cell B1)
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The function to create a Random sample is =RAND()

Type =Rand() on

cell B2 and press enter (this action will generate a random number).
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Left Click twice on the right hand side of cell B2. (this action will copy the RAND formula to
the rest of the column).
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One of the problems with random sample is that every time we refresh the screen or type
anything, the computer will generate a new random value. Since we want to store the initial
select the random value column and copy and paste values.

random value, we
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Now, highlight the entire data set.
Click on the Data Tab
Click Sort

Sort your data according to the random sample.
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A2 ~ Jx| 18100001
A \ B e D E F G A [ J K

1 Case # Random
| 2] 18100001 0.561507307
| 3| 18100002 0.539447611
| 4 | 18100003 0.363248701 s t‘ - M
| 5 | 18100004 0.84740911 —
| 6 | 18100005 0.336216174 [ 4] Add Level ” 7% Delete Level “ =3 Copy Level H o (| l Options... I [¥] My data has headers
| 7] 18100006 0.929859777 Cort On Quder
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| 9] 18100008 0.397500428
| 10 18100009 0.143197459
| 11 18100010 0.570059834
| 12] 18100011 0.81627517

13 18100012 0.826943799
14] 18100013 0.626976005) |
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Now that your case numbers are randomly selected, you can pick the cases according to
the percentage of cases you want to review. If your data set has 100 cases and you want
to review 10%, then you will pick the first 10 cases on your data set:

A B

1 Case # Random

2 13100021 0.000593306
3 18100298 0.001698196
4 18100426 0.003148474
5 13100331 0.005750771
6 18100439 0.009865847
7 183100133 0.009988418
8 18100432 0.01170124
o 18100317 0.013594619
10 13100117 0.019383069
11 18100154 0.022973595

3|Page



LEIAG-Excel Workshop

Stratified Random Sample

So now you want to do something more complicated and include more than one category,
this is where you can utilize an Excel Stratified Random Sample.

The difference between a random sample and a stratified random sample is that with a
stratified random sample we want to select a certain number or records from more than
one category (example: type of case, Assigned Investigator, findings, etc.)

For this exercise, [ am going to select 3 different categories (Case #, Assigned Investigator

and City) from the main data set and paste them into the Stratified Random Sample Tab.
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Assigned Investigator

2 18100001 TOONe e HAEE San wvlarcos
3 18100002 JONES, JESSICA Vista

4 18100003 HERNANDEZ, REYNALDO Vista

5 18100004 SMITH, KIRSTIN Imperial Beach
6 18100005 YOUNG, MICHAEL Vista

7 18100006 JONES, JESSICA San Marcos
8 18100007 HERNANDEZ, REYNALDO Imperial Beach
9 18100008 SMITH, KIRSTIN San Marcos
10 18100009 YOUNG, MICHAEL Vista

Type =Rand() on cell D2 and press enter (this action will generate a random number).
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1 Case # Assigned Investigator City Stratified
2 18100001 YOUNG, MICHAEL San Marcos
3 18100002 JONES, JESSICA Vista
4 18100003 HERNANDEZ, REYNALDO Vista
5 18100004 SMITH, KIRSTIN Imperial Beach
6 18100005 YOUNG, MICHAEL Vista
7 18100006 JONES, JESSICA San Marcos
8 18100007 HERNANDEZ, REYNALDO Imperial Beach
9 18100008 SMITH, KIRSTIN San Marcos
10 18100009 YOUNG, MICHAEL Vista

4|Page




Home  Insert Formulas Data Review

Page Layout

View

Now, highlight the entire data set.
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1 Case # Assigned Investigator City Stratified
2 18100001 YOUNG, MICHAEL San Marcos 0.142050059
3 18100002 JONES, JESSICA Vista 0.158977648
4 18100003 HERNANDEZ, REYNALDO Vista 0.729329976
5 18100004 SMITH, KIRSTIN Imperial Beach 0.985911163
6 18100005 YOUNG, MICHAEL Vista 0.039939994
7 18100006 JONES, JESSICA San Marcos 0.0388633
8 18100007 HERNANDEZ, REYNALDO Imperial Beach 0.298094361
9 18100008 SMITH, KIRSTIN San Marcos 0.785751442
10 18100009 YOUNG, MICHAEL Vista 0.583413954
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Phoenix-Excel Class
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A2 M Jfe 18100001
A B \ C | D | € F G
1 Case # Assigned Investigator City Stratified
| 2 | 18100001 YOUNG, MICHAEL San Marcos 0.142050059
| 3 | 18100002 JONES, JESSICA Vista 0.158977648
| 4 | 18100003 HERNANDEZ, REYNALDO Vista 0.729329976
| 5 [ 18100004 SMITH, KIRSTIN Imperial Beach 0.985911163
| 6 | 18100005 YOUNG, MICHAEL Vista 0.039939994
| 7 | 18100006 JONES, JESSICA San Marcos 0.0388633
| 8 | 18100007 HERNANDEZ, REYNALDO Imperial Beach 0.298094361
9 18100008 SMITH, KIRSTIN San Marcos 0.785751442
F 18100009 YOUNG. MICHAFI Vista 0583413954
Click on the Data Tab
Click Sort

Sort your data according to the random sample.
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A2 - ( /| 18100001
A | B | c D E
1 Case # Assigned Investigator
Z 18100001 YOUNG, MICHAEL San Marcos 0.142050059
3 18100002 JONES, JESSICA Vista 0.158977648
4 18100003 HERNANDEZ, REYNALDO Vista 0.729329976
5 18100004 SMITH, KIRSTIN Imperial Beach 0.985911163
6 18100005 YOUNG, MICHAEL Vista 0.039939994
7 18100006 JONES, JESSICA San Marcos 0.0388633

== Copy Level ”E 4 My data has headers
Fatrs |

Cal Lo

Sort by ;Assigned Investigator E| :Values E| AtoZ E|
Then by |City || |values =] |[Atoz =]
Then by S& atified E| ;_Values E| meaIIest to Largest E|
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Just remember to always have Random or Stratified as your last column!

Note that you donf have to include the case number; your stratified random sample will
automatically provide you with random case numbers.

You now use the stratified random sample to pick a certain amount of cases per
Investigator and City:

Case # Assigned Investigator City
18100404 HERNANDEZ, REYNALDO Imperial Beach
18100167 HERNANDEZ, REYNALDO Imperial Beach
18100207 HERNANDEZ, REYNALDO North Coastal
18100363 HERNANDEZ, REYNALDO North Coastal
18100054 JONES, JESSICA Imperial Beach
18100090 JONES, JESSICA Imperial Beach
18100198 JONES, JESSICA North Coastal

) 18100138 JONES, JESSICA North Coastal
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Filtering Data

Another useful Excel option is the Filter option. With this option you select data according
to specific text, text color or highlighted data.

In the sample provided, most of the text is black. However, all the Aggravated Assault cases
are highlighted in yellow, and the Forcible Rape cases are in red text. (we do this to mark or
easily identify specific data that we may want to easily find it a later time)

To filter data:

Highlight your data set and click the Sort and Filter option, then select Filter
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2 18100001 2/2/2018 YOUNG, MICHAEL -avated Assault San Marcos Suspended '
3 18100002 2/2/2018 JOMNES, JESSICA Burglary/Breaking & Entering Vista DA Reject
4 18100003 2/2/2018 HERNANDEZ, REYNALDO Counterfeiting/Forgery Vista Arrest
5 18100004 2/2/2018 SMITH, KIRSTIN Credit Card/Automatic Teller Fraud Imperial Beach Dept Closure
6 | 18100005 2/2/2018 YOUNG, MICHAEL D ion/Damage/Vandalism of Property Vista Dept Closure
7 18100006 2/2/2018 JOMES, JESSICA Disorderly Conduct San Marcos Arrest
8 18100007 2f2/2018 HERMANDEZ, REYNALDO Drug/narcotic Violations Imperial Beach Arrest
] 18100008 2f3f2018 SMITH, KIRSTIN False P fSwindle/Confidence Game San Marcos Exception
10 18100009 2f3/2018 YOUNG, MICHAEL Forcible Rape Vista Arrest
11 18100010 2/3/2018 JOMES, JESSICA Motor Vehicle Theft San Marcos Arrest
12| 18100011 2/3/2018 HERMANDEZ, REYNALDO Robbery Vista Arrest
13| 18100012 2/3/2018 SMITH, KIRSTIN Shoplifting Imperial Beach Arrest
14| 18100013 2f3/2018 YOUNG, MICHAEL Simple Assault San Marcos Suspended
15| 18100014 2f3f2018 JONES, JESSICA Trespass of Real Property San Marcos Suspended
16| 18100015 2/3/2018 HERNANDEZ, REYNALDO ‘Weapon Law Viclations Vista Arrest
17| 18100016 2/3f2018 SMITH, KIRSTIN Aggravated Assault Imperial Beach Arrest
18| 18100017 2f3/z2018 YOUNG, MICHAEL Burglary/Breaking & Entering Vista Arrest
19| 18100018 2/3/2018 JONES, JESSICA Counterfeiting/Forgery San Marcos DA Reject
20| 18100019 2/4/2018 HERNANDEZ, REYNALDO Credit Card/Automatic Teller Fraud North Coastal Dept Closure
21| 18100020 2/a/2018 SMITH, KIRSTIN D: ion/D: ge/Vandalism of Property  North Coastal Dept Closure
22| 18100021 2/4/2018 YOUNG, MICHAEL Disorderly Conduct San Marcos Arrest
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After you activate the Filter, you will see the following drop down option appear on your
column titles. Click on the desired filter.
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You can now filter by specific text, cell color and/or font color.

Excel Subtotal Option

The Excel Subtotal option can be used to total specific rows of data. Let® say that we want
to know how many cases per City we have on our data set, we can do that by using the
Subtotal function.

First, select the column with the data you want to subtotal. Next, click on the Data Tab and
click Subtotal. In the subtotal box, you need to make sure the function is set to EcountRand
that Replace current subtotals and Summary below data are selected Click Ok
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- eelals Phoenix-Excel Class - Microsoft Excel
Home Insert PageLayout Fermulas | Data | Review  View
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1 Case#  AssignedDate  Assigned Investigator Crime Category Gy | ot ==
2 18100004 2/2/2018 SMITH, KIRSTIN Credit Card/Automatic Teller Fraud Imperial Beach
3| 18100007 2/2/2018  HERNANDEZ REYNALDO Drug/nareotic Violations Imperial Beach | | A'Sh dnoein: =
4 | 18100012 2/3/2018 SMITH, KIRSTIN Shoplifting Imperial Beach S ~ *
5 | 18100016 2/3/2018 SMITH, KIRSTIN Aggravated Assault Imperial Beach f:“'“‘l"m“' —:{
6 | 18100026 2/4/2018 JONES, JESSICA Robbery Imperial Beach || T :
7 | 18100033 2/5/2018 YOUNG, MICHAEL Counterfeiting/Forgery Imperial Beach = ‘_
2 18100034 2/5/2018 JOMES, JESSICA Credit Card/Automatic Teller Fraud Imperial Beach
9 18100052 2/ef2018 SMITH, KIRSTIN Drug/narcotic Violations Imperial Beach
10 18100053 2/6/2018 YOUNG, MICHAEL False Pretenses/Swindle/Confidence Game | Imperial Beach "
11 18100054 2/6/2018 JOMES, JESSICA Forcible Rape Imperial Beach
12 18100063 2/6/2018 HERMNAMDEZ, REYNALDO Counterfeiting/Forgery Imperial Beac o Replace urrent sublotals
13| 18100066 2/7/2018 JONES, JESSICA Disorderly Conduct Imperial ) Bage hreak: between grotips
14| 18100070 2/7/2018 JOMNES, JESSICA Motor Vehicle Theft Imperial Beach Sy Summary below data
15| 18100071 2/7/2018 HERNANDEZ, REYNALDO Robbery Imperial [+ Remave Al Cancel |
16| 18100075 2/7/2018 HERNANDEZ, REYNALDO Weapon Law Violations Imperial Beach |- e
17 18100082 2/8/2018 JONES, JESSICA Drug/narcotic Violations Imperial Beach Arrest
18 18100088 2/8/2018 SMITH, KIRSTIN Simple Assault Imperial Beach |Located Missing Person
13 18100090 2/8/2018 JOMES, JESSICA ‘Weapon Law Viclations Imperial Beach Arrest
20 18100093 2/8/2018 YOUNG, MICHAEL Counterfeiting/Forgery Imperial Beach Suspended
21 12100094 2/8/2018 JOMES, JESSICA Credit Card/Automatic Teller Fraud Imperial Beach Arrest
22| 18100095 2/9/2018 HERNANDEZ, REYNALDO Destruction/Damage/Vandalism of Property | Imperial Beach Suspended
7218100100 2/ajinia SMITH KIRSTIN Metnr Viahicla Thaft Imnarial Raarh Nant Clacure
H 4 ¥ M Main Data Set  Random Sample  Startificd Random Sample  Fiter Subtotal . Data for Pivot Table  Graph Data 14
e - oo n Ih

The following options will appear on your screen, click on number P2[
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Access  Web Text Sources~ Connections All-
Get External Data Co
_._ E6 - S|
=213 A B
N~ 4 Case # Assigned Date
2 18100004 2/2/2018
3 18100007 2/2/2018
4 18100012 2/3/2018
5 18100016 2/3/2018
6 18100026 2/4/2018
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1[2fa] A B c D | - -
: 1 Casedl Assigned Date  Assigned Investigator Crime Category City
+| 128 Imperial Beach Count 126
+| 247 North Coastal Count 118
+ 285 San Marcos Count 137
+ 505 Vista Count 119
= 506 Grand Count 500
507
508
503

510
511
512

Please note: 1 gives you the grand count, and 3 will give you all the data including the
subtotal.

Pivot Tables

If you want to arrange, summarize data, and drill down on details; you can do so by using
Excel Pivot Tables.

By using the previous data sample we can create a Pivot Table that will give us a total
amount of cases per investigator, as well as the case status.

Start by selecting all your data. Next, click on the Insert Tab and select Pivot Table.

Home  Insert ' Pagelayout Formulas Data Review  View
EEE TR m‘aﬁ_ﬂ'&\_*) wm i B Q &2 4 [
PivotTable Table = Picure Clip Shapes SmartArn Screenshot Column  Line Fie Bar Area  Scatter Other Line Celumn Win/Loss Slicer | Hyperl Il'w Text Header Wordart Signaturg
* Art v b - ¥ b Charts + Bax & Footer Line ~
| [ PivorTable . Hiustrations Charts Sparklines Filter Links Text
i3 Piverchart bt Ji| Cased#
' A | B € | D | E F
4 18100003 HERNAMNDEZ, REYNALDO Counterfeiting/Forgery Vista Arrest
5 18100004 SMITH, KIRSTIN Credit Card/Automatic Teller Fraud Imperial Beach Dept Closure
6 18100005 YOUNG, MICHAEL Destruction/Damage/Vandalism of Property Vista Dept Closure
7 18100006 JONES, JESSICA Disorderly Conduct San Marcos Arrest
8 18100007 HERNAMDEZ, REYNALDO Drug/narcotic Violations Imperial Beach Arrest
g 13100008 SMITH, KIRSTIN False Pretenses/Swindle/Confidence Game San Marcos Exception
10 181000093 YOUNG, MICHAEL Forcible Rape Vista Arrest
11 18100010 JOMES, JESSICA Motor Vehicle Theft San Marcos Arrest
12| 18100011 HERNANDEZ, REYNALDO Robbery Vista Arrest
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After you select Pivot Table, the following window will appear. Since you already selected

the data, all you have to do is click OK.

Create PivotTable

Choose the data that you want to analyze
(@) Select a table or range
Table/Range: [Data for Pivot Table'$A:$E

() Use an external data source

Connection name:
Choose where you want the PivotTable report to be placed
@) New Worksheet
() Existing Worksheet

Location:

( OK N Cancel
— 2

Drag the Assigned Investigator and Case Status to the Row Labels Option.

Drag the Case Status to the column Labels Option.

PivotTable Field List v X
Choose fields to add to report:
| |Case #

[|Assigned Investigator
[ |Crime Category

[Caty

[]Case Status

Drag fields between areas below:

“ Report Filter [fZ] Column Labels

[{Z] Row Labels > Values
I Assigned Investigator ~ Count of Case Status ‘
— Case Status 7

[ | Defer Layout Update Update
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LEIAG-Excel Workshop

The pivot table will give you more than a simple subtotal (as to how many cases per
Investigator), but it will also provide details according to case findings.

Row Labels * Count of Caze Status
= HEBNANDEZ, REYNALDO 169
Arrest 56
D Reject B
Dept Closure 21
Exception 4
Located Missing Person 24
Ko Pros 12
Open 1
Subrnitted DA 4
Suzpended 41
= JOMES. JESSICA 1
Arrest a0
D Reject 4
Dept Closure 1]
Exception 1
Located Missing Person 14
Mo Proz L
Open 1
Subrnitted DA 1
Suspended 25
Urfounded 2
= SMITH. KIRSTIN 93
Arrest K1l
D& Reject 4
Cept Clozure 9
Exception 4
Located Mizzing Person 13
ho Pros 2
Submitted DA 2
Suspended 28
= YOUNG. MICHAEL 137
Arrest B2
DA Heject 1
Dept Closure &
Exception 1
Located Missing Person 2
ho Pros 1
Subrnitted DA 3
Suspended 41
= [blank]
[Blark)
Grand Total 500
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